
 

Town of Whitby Procedure

Procedure Title: Accessible Documents 

Procedure Number: A 010-001 

Reference: Accessible Document Policy A 010 

Date Originated: December 15, 2015 

Date Revised: Not applicable 

Review Date: As required 

Approval: Chief Administrative Officer 

Point of Contact: Accessibility Coordinator 

Purpose  

This procedure applies to all materials and communications produced by the Town of 
Whitby whether produced in house or on behalf of the Town (i.e. consultant reports).  
The standard applies to information or communications an organization can directly 
control, meaning information an organization creates, owns or where a contractual 
relationship with a third party provider allows for modification. If an organization has 
control over the information or communications, they would have to convert it into an 
accessible format or provide it with appropriate communication supports, upon request. 
 
This procedure does not apply to: 

• Products or product labels, unless otherwise stated;  

• Unconvertible information and communications; and 

• Information and Communications that the Town does not control directly or 
indirectly through a contractual relationship. 

Scope 

This procedure and related policy applies to all employees, volunteers, elected officials, 
and third-party contractors who are conducting business on behalf of the Town. 
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1 Definitions 

1.1 Accessible Document – Conforms to the World Wide Web Consortium Web 
Content Accessibility Guidelines (WCAG) 2.0 Level AA and is produced as 
accessible Word, Excel, PowerPoint, PDF, etc.; that passes Adobe Pro XI 
accessibility checker or newer version that becomes available. 

1.2 Accessible Formats – Formats that are an alternative to standard print and 
are accessible to persons with disabilities. Accessible formats may include, 
but are not limited to: large print, recorded audio, electronic formats such as 
DVD’s and CD’s, Braille and other formats usable by people with disabilities. 
This term is also known as “alternative formats”. 

1.3 Communications – The interaction between two or more people or 
organizations (or any combination of them) where information is provided, 
sent or received. 

1.4 Conversion Ready – An electronic or digital format that assists conversion of 
information into an accessible format (i.e.: Braille, large print, audio cassettes, 
CD’s, DVD’s, etc.). 

1.5 Information – Includes data, facts and knowledge that convey meaning and 
that exists in any format such as text, audio, digital or images. 

1.6 Unconvertible Information – Information that is not technically feasible to 
convert, or the technology to convert the information is not readily available. 

1.7 Website – Is a set of web pages that are available to the public and contain a 
collection of related text, images, videos, audio and other digital assets. It is 
accessible through an internet address known as a Uniform Resources 
Locator (URL). 

1.8 Web Content Accessibility Guidelines (WCAG) – Is an international 
standard for making websites and web content accessible to people with a 
wide range of disabilities. 

1.9 WCAG 2.0 Level AA – Conformance level in WCAG Version 2.0, to meet 
conformance Level AA, all Level A and Level AA success criteria must be 
met. 

2 Responsibilities 

2.1 All employees, volunteers, elected officials and third-party contractors 
are responsible for: 

• Being knowledgeable about accessibility requirements; 

• Following the Town’s Accessible Document Guide for the creation of all 
information and communications;  



Procedure Title: Accessible Documents 
Procedure Number: A 010-001  Page 3 of 4 

• The creator shall complete their documents, including running accessibility 
check and correcting any issues, also providing any alternative text 
necessary for supporting documents, i.e. for mapping; 

• The creator will ensure that all documents and print materials have 
appropriate colour contrast, as outlined in the Accessible Document 
Guide, and avoiding the use of red tones wherever possible; 

• Ensuring that all correspondence, invoices and other documents 
distributed by the Town to the public indicate that alternative format 
documents are available upon request. The following statement will be 
included in all documents; 

• “The Town of Whitby strives to provide information in a format accessible 
to all people. Complete a request form available at all service counters 
and online at whitby.ca/accessibility or contact the Department 
responsible for the information at 905-668-5803 to request an alternative 
format”; and, 

• Upon request, Town information will be converted to an alternative format 
or provided with a communication support. Staff receiving requests or 
inquires will forward to the appropriate department or provide the 
information in accordance with the Town’s Accessible Formats and 
Communications Supports policy and procedures. 

2.2 Staff Liaisons to Advisory Committees or Supervisors of Volunteers are 
responsible for: 

• Providing support to volunteers in the creation of accessible documents 
and information. 

2.3 Clerical Staff are responsible for: 

• Providing support to employees within their Departments; in terms of 
running the final accessibility check through Adobe Pro XI and making any 
minor changes necessary. 

2.4 The Accessibility Coordinator is responsible for: 

• Providing advice and direction on the Accessible Documents Policy and 
Procedures; and, 

• Monitoring compliance with this procedure on an annual basis. 

2.5 Supervisors and Managers are responsible for: 

• Ensuring that they and their staff are familiar with and comply with this 
Procedure; and, 

• Ensuring that third-party contractors adhere to these Procedures in the 
production of information and communications produced on behalf of the 
Town. 

http://www.whitby.ca/accessibility
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3 Procedures 

3.1 Create Accessible Formats and Communication Supports 

• All employees, volunteers, elected officials and third-party contractors who 
are conducting business on behalf of the Town will ensure that information 
is formatted to comply with the Town’s “Guide to Accessible Documents” 
(see Appendix 1).  

• Information formatted to meet the Town’s “Guide to Accessible 
Documents” will most often result in an appropriate accessible format and 
communication support.  

o For example, the information will be compatible with screen reading 
software, which means that a document can be emailed to a person 
with vision loss and used with their own assistive technology. 

• There may be instances when information formatted to meet the “Guide to 
Accessible Documents” does not result in an appropriate accessible 
format and communication support.  

o For example, creation of an accessible document produced as a 
Braille document.   

• In these instances, an alternative will be provided, upon request, in 
accordance with the Town’s Accessible Formats and Communications 
Supports Policy HR 020.  

• Formatting a document to the guide will ensure it is conversion ready for 
the recipient. 

Appendices 

Appendix 1 Town of Whitby “Guide to Accessible Documents” 

Original Approved and Signed. 

Robert Petrie, Chief Administrative Officer, x2211  

October 4, 2016 

Date 
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Introduction 

The Accessibility for Ontarians with Disabilities Act (A.O.D.A.) passed in 2005. This Act 

is meant to create accessibility for all Ontarians with disabilities by January 1, 2025. 

The Integrated Accessibility Standards, Ontario Regulation 191/11 establishes the 

accessibility standards for Information and Communications, Employment and 

Transportation. This Regulation will remove barriers in the areas of Information and 

Communications, giving people with disabilities access to more of the information we all 

depend on. 

Corporate Statement of Commitment 

The Corporation of the Town of Whitby is committed to providing an accessible 

environment in which residents, visitors and employees have equitable access to 

municipal programs, services and facilities in a way that respects the dignity and 

independence of each individual. The municipality is dedicated to ensuring that all 

legislated obligations under the A.O.D.A. are met and that compliance with these 

standards is maintained. 

Accessibility is not just a matter of legal compliance.  

The A.O.D.A. requires the Town to provide accessible formats for people with 

disabilities, upon request. With little effort, we are in a position to do even better.  

Implementing Accessibility Standards will facilitate inclusiveness and enhance access to 

municipal goods, services and facilities in a way that respects the dignity and 

independence of people with disabilities.  

This Guide to Accessible Documents aims to produce website ready, user-friendly 

documents for all customers and staff, including people with disabilities.  

 

Readability should be the first step in making administrative documents 

accessible to everyone. 
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Accessible communication doesn’t mean more work 

Many people worry that providing accessible communication will change the way we do 

things.  It will. But it doesn’t necessarily mean more work. 

By making small but important changes in how we produce communications materials, 

we can make them accessible to people with disabilities with very little effort. The 

following sections will outline changes to be incorporated into Town communications, 

increasing readability for all customers. 

What does it mean to make information accessible? 

Making information accessible means considering the needs of persons with disabilities; 

• When you create new information, think about what might help someone who has 

low vision, hearing loss or a learning disability to understand it; 

• To make your existing information more accessible, recreate it in an accessible 

format; for example, use large print for someone with vision loss;  

• You can also help someone to understand the information; for example, reading a 

menu to someone who is dyslexic or using written notes to communicate with 

someone who is Deaf. This is called “communication support.”  

• There are many ways to make accessible formats. Some examples are: Braille, 

accessible electronic formats, accessible audio formats, large print, or reading 

information aloud to the person directly. 

Assistive Technology 

Some people with disabilities use assistive technology, such as screen readers, braille 

displays, or a modified keyboard or mouse to access information in documents using 

their computers. Screen readers help a person who may be blind, low vision, or have a 

developmental or learning disability to navigate a computer screen. The screen reader 

reads the information on the screen out loud to the person using it. 
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Small changes, big rewards: Making all documents more accessible 

When developing written communications, decisions on things like font style, colour and 

size are often done mostly for an aesthetic perspective. All too often authors and 

designers concern themselves with what looks best, instead of what will be easiest to 

read. 

There are several items to consider when creating written communications, which will 

make it easier for people to read and understand the content. 

Plain Language 

Plain language is text that the reader can understand the first time they read it. It 

sounds easy enough, but text is often cluttered with acronyms, jargon and complex 

sentence structure. 

Written material is in plain language if your audience can: 

• find what they need; 

• understand what they find; and, 

• use what they find to meet their needs. 

Text that is clear and easy to read benefits customers with learning disabilities and low 

literacy skills. It improves comprehension for all users and allows for easy adaption to 

other formats. 

When writing in plain language, remember to: 

• keep your intended audience in mind, 

• use an active voice, 

• shorten sentences, 

• use common everyday words, 

• eliminate jargon and unnecessary words, 

• use simple sentence structure and grammar. 
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Example: 

Before 

When the process of freeing a vehicle that has been stuck results in ruts or 

holes, the operator will fill the rut or hole created by such activity before removing 

the vehicle from the immediate area.  

After (Plain Language) 

If you make a hole while freeing a stuck vehicle, you must fill the hole before you 

drive away. 

Reading Level 

Microsoft Word can determine the grade level at which documents are written and 

readability of the document. It is not a perfect measure, but it is a good guideline. Aim 

for a Grade between 8 and 10 level.  

For reading ease, the best text should contain shorter sentences and words. A score on 

the Flesch Reading Ease between 60 and 70 is largely considered acceptable.  (See 

page 42 for instructions.) 

The following is also helpful to assess the ease of readability in a document:  

90-100: Very Easy  

80-89: Easy  

70-79: Fairly Easy – Grade 8 level 

60-69: Standard – Grade 10 level 

50-59: Fairly Difficult  

30-49: Difficult  

0-29: Very Confusing
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Aim for a Clear, Organized, Readable document  

Clear print that is organized will be readable to a broader audience.  

Use the following guidelines to make documents more accessible:  

Clarity:  

• Do not provide too much information.  

• Use bullet point summaries, rather than dense text.  

Organization:  

• Do not place text over cluttered backgrounds.  

• Use wide margins (minimum 0.5 inches)  

• Use larger line spacing.  

• Leave larger spaces between sections than between paragraphs.  

Readability:  

Printed Material should have a matte finish, not glossy.  

Margins and columns 

The most accessible page is 8.5 x 11 with one-inch margins on each side. This 

promotes readability and is most convenient for people using magnifiers. 

Separate text into columns to make it easier to read. Columns require less eye 

movement and less peripheral vision. 

Alternate formats and Communication Supports 

Alternate formats are other ways of publishing information besides regular print (e.g. 

braille). Always, include the statement “Accessible formats and communication supports 

available upon request.”  

For more information contact, the Accessibility Coordinator at accessibility@whitby.ca  

mailto:accessibility@whitby.ca
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Font, Design and Accessible Formats 

Use appropriate Font Family 

Avoid complicated, decorative or handwriting fonts.  

Choose “Sans-Serif” fonts such as Arial. These fonts have easily recognizable upper, 
lower-case and numerical characters.  Narrow versions of these fonts should be 
avoided.  
 

Arial  

Garamond 

Monotype Corsiva 

This font is accessible 

This font is not accessible 

This font is not accessible  

 

The Town’s standard font family is Arial. 

 

If you wish to use another font beyond Arial in marketing materials, please check 

with the Corporate Communications Officer and the Accessibility Coordinator. 
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Use appropriate Font Size 

Make text large, preferably between 12 and 18 points. 

The size of the font is a fundamental factor in legibility. Font size 12 is the Town 

standard for main body text. A minimum font of size 16 is the Town standard for 

presentation documents. A font size of 10 point and smaller is not accessible and 

should be avoided where possible. 

Font Size 10   Size 10 or less is not accessible  

Font Size 12   Town standard for main body text  

Font Size 14  Town standard for main headings  

Font Size 16  Town standard for large print 

Note: Font size varies between font families. This guide is based on the Arial font. If 

using sans-serif fonts other than Arial, use Arial as the base for determining appropriate 

font size. For example: 

Arial, font size 12   Town standard for main body text 

Calibri, font size 14  Calibri 14 is similar in size to Arial 12 

Verdana, font size 11  Verdana 11 is similar in size to Arial 12 

Use Bold for emphasis, not italics or underlining  

Avoid italics and underlining, to improve readability.  

Italic fonts are more difficult to read than regular fonts, mainly due to the output of 

angled characters on a digital screen that has poor resolution. There may be exceptions 

to using italics, such as when required to meet standard formatting (for example, citation 

in legal documents). Keep in mind, if the font is very large, italics may be more legible, 

but as a general rule, avoid italics where possible.  
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Underlining interferes with lower case letters and should be avoided for emphasis. 

Only use underlining when describing links, such as email addresses and web pages. In 

this application, use the international standard of a blue font. For example, 

www.whitby.ca  Microsoft Office products typically recognize email addresses and web 

page links and automatically apply this format.  

When following these simple rules, we not only comply with the requirements of 

the Accessibility for Ontarians with Disabilities Act, 2005, we make documents 

easier to read. 

Avoid sentences in all UPPER CASE letters  

A sentence written with a combination of upper and lower case letters 
is easier to read.  

The ascenders and descenders found in lower-case letters provide word shape, causing 

mental reading clues to speed up the process of reading. Sentences written in all upper 

case do not benefit from these clues and are more difficult to read.  

 

It may make sense to use all upper case in some instances, such as short headings, 

titles with a maximum of two words or when text is used as a graphic image and not 

intended to be read. In these examples, there is no benefit to having the mental reading 

clues. However, upper case can give the impression of shouting at the reader and 

therefore should be avoided where possible.  

If the intent is to convey a shout, an exclamation point may be better. Screen readers 

generally do not read text differently if it is in all upper case letters, so listeners will not 

know that the author is shouting. Screen readers do change the voice inflection with 

exclamation points.  

Also, upper case acronyms should have periods to allow screen readers to properly 

interpret the text as an acronym and not a word. For example, A.O.D.A. is more 

accessible than AODA. 

http://www.whitby.ca/
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Use appropriate Text Alignment  

Align text to the left margin.  

Aligning text to the left margin makes it easier to find the start of the next line and 

keeps spacing between the words even.  

Centre alignment is not accessible. 

 

Left and right alignment (justified) is not accessible. It causes uneven spaces 

between words. It is more difficult to read because the human eye cannot move 

smoothly along the sentence and has to search and jump to the start of each word.  

Where images are used with text, align the image to the left of the page with the text 

directly above or below. Alternatively, align the image to the right of the page with the 

“Square” text wrapping option and keep the text aligned left.  
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Use standard Navigational Aids  

Use navigational aids to organize information and make documents 
easier to understand.  

When using Microsoft Office, use the “Styles” tool to quickly apply a set of formatting 

choices to document headings and body. Benefits include:  

• Increased readability  

• Screen readers can identify and navigate sections  

• A table of contents with links to document sections can be automatically generated, 

as formatted in this document.  

• Formatting is consistent throughout the document. 

 

Styles 

Styles are formatting instructions, such as ‘Heading 1’ for the title of your document, 

‘Heading 2’ to indicate the top-level heading. ‘Heading 3’ to indicate a sub-heading and 

the ‘Body Text’ style for the body text in your document. It is best to use the built-in 

styles in Word as opposed to creating your own, as not all assistive technologies will be 

able to understand custom styles. 
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Use High Contrast  

Use a minimum 7:1 colour contrast ratio between the background and 
the foreground.  

What does a 7:1 colour contrast ratio mean?  

The better the contrast between the background and the foreground, the more legible the 

document will be. Black text on a white background provides the best contrast, but is not the 

only option.  

 

A good way to check contrast is to print in black and white and check if the document is 

legible. Online contrast testing tools are also available, which allow you to test colour 

combinations to determine the exact contrast ratio.  

www.snook.ca/technical/colour_contrast/colour.html  

Note: fonts larger than size 18 and fonts formatted to be bold have lesser requirements 

than a 7:1 contrast ratio. Adequate contrast is required for only objects that are intended 

to be read. 

Note: Don’t use background stationery (i.e. colours, images) in emails. 

Clean design and simplicity 

Use distinctive colours, sizes and shapes on the covers of materials to make them 

easier to tell apart. Don’t overlap too many images and/or text elements. Reduce 

distractions by not using watermarks, clipart graphics, WordArt or complicated 

background designs. 

http://www.snook.ca/technical/colour_contrast/colour.html
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Make white space your friend 

As important as the right font and size is in achieving an accessible document, so, too, 

is the amount of white space on a page. An adequate amount of space between lines of 

text and the amount of space between individual characters will increase its readability. 

Additionally, leaving a space between paragraphs is helpful for individuals with low 

vision. 

Use Alt Tags for graphics  

Add a short description to all graphics inserted into a document.  

An “Alt tag”, or alternative text, is a brief description of any graphic inserted into a 

document. It can be read by a screen reader to allow someone with a vision disability to 

understand what the graphic is.  

It is also displayed in place of the image when software does not support the display of 

images or when the user has chosen not to view images. As an added bonus, it can be 

read by search engines.  

For example, the image below of this text has the following alt 

tag:  

How to add an Alt Tag to the pine tree symbol from the 

City of Peterborough "It's a Natural" logo.  

If reading this document on your computer, place your cursor 

over the image and see for yourself! 
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Use appropriate Leaders  

Avoid Dot leaders that are often used in a Table of Contents.  

What is acceptable?  

Dot leader ……………………………………………………….  No  

Solid line leader __________________________________  Yes  

No leader  Yes  

Note: a table of contents with no leaders is only acceptable when there is generous 

spacing between lines. 

Use Page Numbering  

Add automatic page numbering using the Header and Footer tool  

Numbering the pages of a document helps readers to effectively navigate and reference 

the contents.  

Microsoft Office products have a variety of page numbering templates that can be 

automatically inserted into documents.  

This document uses the automated page numbering feature available in Microsoft 

Office. 

  



 

19 

 

Use a table of contents 

Use a table of contents that indicates the different sections of the document using 

letters, instead of page numbers. This is because products developed from the template 

will not necessarily have the same page numbers, making a traditional table of contents 

useless. 

Insert page numbers after converting the template to the desired format. 

Use of Accessible Tables and Charts  

Avoid tables and charts where possible.  

There are times when using tables and charts are the most efficient way to express a 

large amount of information, making the information more understandable for most 

readers. When using tables and charts, ensure they are formatted to be as accessible 

as possible to all readers.  

All of the basic accessibility considerations that are applied to documents must also be 

applied to tables and charts. For example:  

• Use appropriate font size  

• Add alternative text  

• Use appropriate text alignment  

Additionally, ensure tables include column headings and where possible, just one row of 

headings. Keep tables simple by avoiding merged cells. If tables split across pages, set 

the header to show at the top of each page.  

When creating charts, use formatting options to create different types of lines or apply 

textures rather than colours to differentiate information for users who are colour blind. 

Of course, there are times, such as preparing budget documents, when charts and 

tables are the most efficient and best way to express a large amount of information. 

In these cases, staff should be prepared to provide an accessible format of this 

information if requested. 
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Explain graphics, tables, charts and maps using text 

All graphic elements that contain information relevant to the document require a text 

explanation. The explanation needs to be written by the same person responsible for 

writing the document. Having someone else describe the graphic elements may provide 

an incorrect interpretation. 

When explaining complicated visuals, be sure to identify the type of visual (chart, graph, 

map, etc.) along with the title, purpose and the meaning of the data. 

It is not necessary to provide a separate text explanation if one already exists in the text 

of the document. In this case, refer to the visual in the text of the document. 

It is also unnecessary to provide text explanations for graphics used for visual appeal, 

such as designer lines, borders etc. Photographs also used for visual appeal and not 

having a great deal of relevance can be given very short descriptions. 

Use Real Lists  

Format lists as “real lists” by using automatically generated bullets or 
numbering systems.  

When creating lists, it is important to format them as a “real list”. Otherwise, assistive 

technologies such as screen readers will interpret the list as a series of short separate 

paragraphs instead of a coherent list of related items. Microsoft Office products have a 

variety of automatically generated list options.  

Use numbered lists if the information is sequential and use bulleted lists if the 

information is a related set of points. A screen reader will announce the information as a 

list. 
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Use Accessible Forms  

All forms placed on the City website should be fillable.  

All forms placed online should be fillable – meaning a user can fill out the information 

without having to print the form and fill it out by hand. Except in situations where an 

applicant must attend city hall in person, forms should be able to be submitted via email. 

Tips when creating forms:  

• Organize the fields chronologically.  

• Ensure forms are keyboard accessible.  

• Make sure label and field locations are easy to use.  

• Make sure the information asked is short and basic.  

• Avoid using asterisks (*) to indicate required fields.  

• Offer standard entry fields for phone numbers.  

• Where signature is required, ensure there is sufficient space. 

Start with a new template 

Every office document starts with a template, even if it is a blank page. 

All Town of Whitby templates will be updated to ensure accessibility, so it is imperative 

to always create a document from a new template. 

Using a new template will also ensure you are using the most up-to-date version, 

meaning you’ll get other changes made to the template. 
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Design elements 

When creating documents, organize your information using the following design 

elements: 

1. Section headings 

2. Subsection headings 

3. Paragraph headings 

4. General text 

Using the above design elements in your document creates a document structure 

(hierarchy) that is easier for everyone to understand, and enables assistive technology 

to easily navigate through the document. 

Design guidelines 

• Divide your information into short sections. 

• Make a table of contents for a large or long document. 

• Use lots of headings. 

• Structure your writing by putting the main message first. 

• Use Arial 12 font for the body text in your document. 

• Avoid using all upper case letters. 

• Graphics such as diagrams, tables or charts should be used in explaining text. 

Make sure they have informative headings. 

• Use tables sparingly, refer to page 10. 

• Margins should be 1” all around. 

• Make sure the text in the document is left justified, with ragged text on the right. 

• The majority of your document should be black and white; use colour sparingly as 

it distracts from the main focus of your document. 

• Make sure you use headings in a logical order. (i.e. without skipping heading 

levels) with the title of the document using Heading 1. 
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Accessible Document Checklist 

 Font Size 

 Font Family 

 Bold (no italics or underlining for emphasis) 

 Upper Case letters (no sentences with all upper case) 

 Text alignment (align to the left) 

 Navigational Aids 

 Contrast 

 Alt Tags 

 Clarity, Organization, Readability 

 Table of Contents Leader 

 Date Format 

 Plain Language 

 Page Numbering 

 Tables and Charts 

 Lists 

 Accessible Forms 

Contact the Accessibility Coordinator if you require more information on any of the 

above topics. 

Michele Cotton, Accessibility Coordinator  

905-430-4306 extension 2331 or cottonm@whitby.ca 

mailto:cottonm@whitby.ca
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How to make accessible documents 
in Microsoft Word 2010:  
A step by step guide 

Creating accessible Word documents 

In order to be accessible, documents should be created using a well-structured 

Microsoft Word document then converted into an Adobe PDF document. 

Your document must have a defined structure, i.e. title, headings, sub-headings. During 

the conversion to PDF, Adobe creates tags from these style elements. These tags then 

become bookmarks describing the layout of a document enabling a screen reader to 

navigate and read it correctly in Adobe. 

Of these features, some need to be set once and some need to be done for every 

document created. 
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Use heading styles 

When working with large documents, headings are a useful way to organize information 

and make the document easier to understand. Styles are formatting instructions, such 

as ‘Heading 1’ for the title of your document, ‘Heading 2’ to indicate the top-level 

heading. ‘Heading 3’ to indicate a sub-heading and the ‘Body Text’ style for the body 

text of the document.  

Default ‘Headings and Styles’ in Word 2010 have been created as Town of Whitby 

Corporate Standards, do not modify them. 

 

Remember to apply Heading Styles in descending order, or you will get an error when 

checking the accessibility. 

You can view the styles available to you in the ‘Styles Gallery’ in the Home Tab Toolbar 

or by opening the ‘Styles Pane’ by clicking on the arrow at the bottom right of the Styles 

Gallery. 
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Styles Gallery: 

 

Styles pane: 

 

To format text using a style, select the text you want to apply the style to, then click on 

the style you want to use from the ‘Styles Pane’ or ‘Styles Gallery.’ 
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Navigational Pane: 

The Navigational Pane allows you to navigate through the document by headings, by 

page or by searching for text or objects. 

To turn on the navigational pane, go to the view tab and check the navigational pane 

box. 
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Town of Whitby default heading styles 

The following fonts, font sizes and font colours have been chosen as the Town of 

Whitby Corporate Standard: 

Heading 1 (Arial, 25 pt, bold, blue) 
Heading 2 (Arial, 18 pt, bold, blue) 
Heading 3 (Arial, 15 pt, bold, black) 
Heading 4 (Arial, 13 pt, bold, black) 

Normal (Arial, Arial 12 pt, normal, black) 

Default ‘Headings and Styles’ in Word 2010 have been created as Town of Whitby 

Corporate Standards, do not modify them.  

If you have any questions regarding these preformatted settings, please call the Help 

Desk. 

Use paragraph formatting 

The preformatted Styles have been created with accessibility in mind, not just with fonts, 

but with paragraph formatting.  

The Do Not’s of Paragraph Formatting 

• Do not press Enter to create a space between paragraphs as this creates an 

empty paragraph. Instead modify the style’s paragraph formatting to add space 

above or below paragraphs. 

• Do not use the Spacebar or Tab key to create a first line indent. 

• Do not press Enter repeatedly to force a block of text onto a new page. (Use 

Ctrl+Enter to force a page break.) 

Margins 

For accessibility, keep your margins wide. Your Word has been preformatted to be 8.5” 

x 11” with a 1” margin on all sides. This promotes readability and is most convenient for 

people using magnifiers.  



 

29 

 

To create a new style 

1. In your Styles Pane click on the icon at the bottom ‘New Style.’ 

 

2. A dialog box opens with the options for formatting the style. 

 

3. You can then click the ‘Format’ button on the bottom left corner of the dialog box and 

select the formatting you want to change.  
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4. Font: Only use Arial font, no smaller than 12 pt. Do not create styles using underline 

or italics. 

5. Paragraph: It is important to use proper paragraph formatting to make it easy for 

assistive technology to move from one line to the next. For accessibility, use larger 

white space between paragraphs. Refer to the screen shot following for increasing 

the space between paragraphs in a style. 

 

6. Once you have changed the formatting for that style you can then choose to apply 

the changes to this document only. 

7. Click OK. 
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Make a point with bullets 

Lists should be used to break up dense paragraphs so that the information is easier to 

read and view. Assistive technology recognizes bulleted and numbered lists and 

identifies them as such to the listeners. 

Use bullets to distinguish important individual points. Non-ordered lists should use the 

standard round bullet. Use a numbered list to describe the proper order for a series of 

steps in a sequence. 

You can also create a list style to suit the needs of your document. For instance, if the 

sequence of your numbered list matters then you can modify the numbering that is used 

in that style. You would choose to create a new style and then when you click on the 

‘Format’ button you choose ‘Numbering…’. You can then modify the new style to what 

you want as seen in the following screen shots. 
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Add a document title 

A document title is not the same as a document name. Descriptive and meaningful titles 

are important in case the document is converted to HTML. 

To change the title of the current document: 

• From the File tab choose Info. 

• On the right side, for Title; enter an appropriate title. 

 

Use a table of contents 

A table of contents is necessary to navigate large documents for everyone, not just 

persons with a disability. As the author, you have to decide on what headings to include 

then apply an appropriate heading style to it. You will need to do the following: 

• Insert a page break before your content to ensure the table of contents does not 

include the page number 1 

• Add page numbers 

• Insert a table of contents 

To insert a Next Page Break: 

1. Position the insertion point before your content. 

2. From the Page Layout tab, in the Page Setup group, click on the Breaks button. 

3. Under Section Breaks, select Next Page. 
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Add page numbering 

Numbering the pages of your document helps to navigate the document effectively and 

reference its content. For assistive technologies, it provides a valuable point of 

reference within the document. 

To Insert page numbers: 

1. Go to the ‘Insert’ tab in Word. 

2. In the Header & Footer section, select ‘Page Number.’ 

 

3. Select ‘Format Page Numbers.’ 

4. Select the page number format characteristics that you would like in your 

document. 

Insert a table of content 

1. Position the insertion point where you would like to insert the table of contents. 

2. From the References tab in the Table of Contents group, click on the Table of 

Contents icon. 

3. Select Insert Table of Contents. 

For Tab leader from the drop-down menu select None.
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4. For Show levels, specify the number of levels (headings) in your document – 3 is 

the default. 

  
5. Click on the OK button. 

Update a table of contents 

You will need to update your table of contents as you add and remove content. It will not 

update automatically. 

To update a table of contents: 

1. Right click on the existing table of contents, select Update Field. 

2. Select either Update Page Numbers only if you add text or Update Entire 

Table if you added new headings to your document. 

3. Click on the OK button. 
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Alternative text for pictures 

Alternative text is a text-based representation of any images in your document (graphics 

including pictures, logos, charts, etc.). This is done so that the content of the image can 

be read with assistive technology, such as screen readers. 

Adding alternative text to an image 

1. Select the image. 

2. Right click on the image and choose ‘Format.’ 

 

3. Then select ‘Alt Text’ in the left column and Insert the Alt text title and description 

for the picture.  (Note: If your document is saved as a .doc the ‘Alt Text’ tab is to 

the far right.) 

 

Format Picture window as a .doc (Word 2003 

version) 

 

Format Picture window as a .docx (Word 2010 

version) 
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4. Once you have completed entering your title and description you can close this 

window. 

Guidelines for Alt-Text 

• Use a concise description for the ‘alternative text’ of simple graphics. 

• Insert a short ‘alternative text’ plus a longer description of complex images in the 

main text or as a footnote in your document. 

• If the picture is a link to another document or a website, indicate the target link in 

the ‘alt text’ field. 

• Try to answer the question ‘What information is the image conveying?’ 

• If the image contains meaningful text, make sure that all of the text is conveyed 

in the alternative text. 

Formatting pictures 

For accessibility, any images you insert into a document must be formatted to be ‘In 

Line with Text.’  
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Use tables only when necessary 

First you must consider if you need to use a table. Screen readers may not read tables 

that are not formatted properly or are too large and complex. Tables are read by screen 

readers row by row across the columns. Even if some tables are properly formatted they 

may be too complex for people to understand. You should describe the contents of the 

table used and what it is conveying within the body of your document. 

For this reason, tables should be used sparingly. However, if a table is required it is 

important that it be set up correctly. 

Ensure table headers are formatted to repeat or you will get an error when you check 

for accessibility. 

Guidelines for tables 

• Only use simple tables. 

• Make sure that your table structure makes sense when you read the information 

from left to right, row by row. 

Creating accessible tables 

1. Use the ‘Insert’ Tab. 

2. Click on Table. 

3. Define your table structure, either by selecting the boxes, or by clicking on Insert 

Table. 
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4. Once your table has been created, click on the Design Tab, in the Table Style 

Options group, make sure that the ‘Header Row’ check box is selected.

 

Repeat Table Header Rows 

For accessibility, Table Header Rows need to be defined in every table.  

If a table does not fit onto one page, make sure that you carry the headers of the table 

to the second page by turning on the ‘Repeat as header row at the top each of page’ 

option. 

1. Select the cells in your header row. 
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2. Right Click on the Table and select ‘Table Properties...

 

3. Place check mark in the ‘Repeat as header row at top of each page’. 

4. Click on OK. 

Tables breaking across pages 

To prevent content in one row from breaking across a page, turn off the ‘Allow row to 

break across pages’ option for that row only. This option is available by right-mouse 

clicking over the table, and then choosing the Row tab in Table Properties. 
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To add alternative text: 

1. Right click on the table then select Table Properties. 

2. Select the Alt Text tab. 

3. For Title: enter a title. 

4. For Description, enter a description of the content. 

 

5. Click on the OK button. 
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To create a caption for a table 

1. Once you have created your Table select the entire table and go into ‘Table 

Properties.’ 

 

2. Then type in your caption text beside the table name. You can then position the 

caption above the table by selecting the position option as shown in the screen 

shot below. 
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User Settings—Microsoft Word 2010 

Readability statistics 

Microsoft Word can determine the grade level at which documents are written. It is not a 

perfect measure, but it is a good guideline. Aim for a Grade 8–10 level and a reading 

ease around 65. 

If you don’t see the grade/reading level when you use ‘Spelling & Grammar’ in your 

Word documents, follow these simple steps: 

1. Click the File tab. 

2. Select Options. 

3. On the left hand side select Proofing. 

4. Under the When Correcting Spelling and Grammar in Word, enable Show 

readability statistics. 

5. Click the OK button. 

   

After you enable this feature, open a file that you want to check, and check the spelling. 
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Accessibility Checker in Microsoft Word 2010 

The Accessibility Checker helps users create more accessible content. By identifying 

areas that might be challenging for users with disabilities, you can fix potential problems 

within your content. 

This feature is available in Word 2010 and will only work on documents saved as a 

.docx file. 

Save your document in the correct format 

1. Before using the checker, you need to save your document from within Word 

2010 in the .docx format. 

2. When you save your document, the option ‘Maintain compatibility with previous 

version of Word’ may be shown. If shown, make sure that it remains unchecked. 

 

If you do not follow steps 1 and 2 above, the following will show when you try to run the 

checker: 

 

Note: If you must have a .doc file format for an external party, save the file in the .docx 

format first, run the accessibility checker; make any necessary fixes, then save the 

checked/fixed document in the old format. 
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Running the Word 2010 Accessibility Checker 

1. Click on Info under the File tab. 

2. Click on ‘Check for Issues’, then select ‘Check Accessibility’ from the drop down 

list. 

3. The Accessibility Checker pane opens. 

 

The Accessibility Checker checks your document against a set of possible issues. Each 

Issue that the Accessibility checker finds is classified as an Error, Warning or Tip. 

 An Error is for content that makes a file very difficult or impossible for 

people with disabilities to understand. 

 A warning is for content that in most but not all cases makes a file 

difficult for people with disabilities to understand. 
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 A tip is for content that people with disabilities can understand, but that 

might be better organized or presented in a way that would improve 

their experience. 

Fixing accessibility issues 

Whenever the Accessibility Checker finds an issue, the task pane shows information 

about why the content might be inaccessible. When you select an issue, it shows you 

how to repair or revise it. 
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Accessibility Checklist 

Making documents accessible benefits all users so it’s a good practice to follow in 

general. The following is a checklist of steps to ensure accessibility. 

 Use styles when formatting Word documents rather than character formatting. 

 Avoid using text boxes, tables and charts in Word documents.  

 Add alternative text to graphics in your files. 

 Form fields should be interactive. 

 Use navigational aids such as links, bookmarks, headings and a table of contents 

because these can be accessed using a keyboard without relying on a mouse. 

 Ensure the security settings don’t interfere with a screen reader’s ability to convert 

the on-screen text to speech. 

 Generate the PDF file with tags. 

Check the results after generating a PDF and fix any errors as required. 
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Creating Accessible Documents 
in Adobe Acrobat Pro XI 
from Microsoft Word:  
A step by step guide 
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Create a PDF document in Word 

Using the Acrobat PDFMaker in Word is an easy way to create a tagged PDF (Portable 

Document File), which will be easy to navigate for individuals using screen reading 

technology. 

To use the PDF Maker Add-on to create a tagged PDF: 

1. Save the accessible Word document (will save as a docx). 

2. From the Acrobat tab, select the Create PDF icon. 

3. Browse to the appropriate location and specify a filename. 

4. Click on the Save button. 

 

Your PDF has now been created, and should open automatically, but it still requires 

some work to ensure accessibility. 
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Creating accessible PDF documents 

Once your document opens in Adobe Acrobat Pro XI, you need to complete the 

following steps for every PDF document to ensure it meets minimum accessibility 

requirements. 

Step 1 – Reading Order 

You must setup the reading order in your document. 

1. Click on the Page Thumbnails icon on the left of your screen. 

2. Select the first page in the Thumbnails pane and then Ctrl+A to select all of the 

pages in your document. 

3. Then right click on that first page and select ‘Page Properties…’ 

 



 

50 

 

4. In the Page Properties window, select ‘Use Document Structure.’ 

 

 

5. Click OK. 

  



 

51 

 

Step 2 – Tab Structure 

You must set the tab structure in each document, but first you must activate the Order 

panel. 

1. To activate the “Order” view in your Navigation Pane, right click on the grey 

vertical bar. 

2. Select “Order” from the list of panes available. The Order icon will now always 

appear on the Navigation Pane. 

3. Now click the Order icon in order to see the document’s Tab Structure. 
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Once you have activated the Order window, you must verify that the reading order of 

each page in the document is correct. 

If you need to remove blank items or re-order items, you can do so in the Order Pane. 

• To delete a blank item (empty paragraph), right click on the item in the order 

pane and select ‘Delete Selected Item Structure.’ 

• To re-order items, select the Item in the Order pane and drag it to the appropriate 

location in your document. 

I  

Example of Reading Order screen 
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Step 3 – Language Properties 

You must set the Language Properties of every PDF Document. To set the language for 

the document: 

1. Click on File in the upper navigation pane. 

2. Click on Properties. 

3. Select the Advanced tab. 

4. Select English under Reading Options > Language. 
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Step 4 – Document Title 

1. In the Description Tab, give your document a title. 

 

2. Click OK. 
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Step 5 – Initial View 

1. In the Initial View tab, change Window Options to Show ‘Document Title.’ 

 

Step 6 – Save 

Now you can Save your changes to your PDF document. 

  



 

56 

 

Accessibility Checker in Adobe Acrobat Pro XI 

Run the Accessibility Check (Full) 

Run the Adobe Accessibility ‘Full Check’ on your document to make sure there are no 

accessibility issues with the PDF document. 

1. To access the Accessibility Check, click on Tools. 

 

2. Under Accessibility, click on Full Check. 

3. Click on the Start Checking button. 

4. If errors are found, you will see the following message: 

 

5. Click OK. 
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6. On the left hand side, using the Accessibility Report pane, select the issue and make 

the necessary corrections. 
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Optimize your PDF Document 

It is good practice to always optimize your PDF file. Especially if your PDF file is going 

to be uploaded onto the web, you may need to reduce the file size. PDF Optimizer 

provides many settings for reducing the size of PDF files. In most cases, the default 

settings are appropriate for maximum efficiency—saving space by removing embedded 

fonts, compressing images, and removing items from the file that are no longer needed. 

1. Open Acrobat Pro. Open an existing PDF or create a new document. 

2. Click ‘File’ and then ‘Save As’ then choose ‘Optimized PDF.’ 

3. Select the button in the upper right that says ‘Audit space usage.’ 
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In the audit report above, you can see that in this PDF images make up 90.39 

percent of the file size so that is clearly where you should spend efforts in trying to 

reduce the size. 

PDF Optimizer lets you customize exactly how you reduce the size of a PDF. The 

settings you choose will depend on how you intend to use the file. 

For example, the image compression you select for a PDF that will be posted online 

will be very different from the image compression you select for a PDF to send to 

print production. 
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4. Next, go to the Settings options on the upper left and choose a setting. 

 

 

Acrobat XI Pro comes with two preconfigured settings; ‘Standard’ and ‘Mobile’ or you 

can create your own ‘Custom’ setting. Most simple documents will be fine in Standard or 

Mobile. Complex documents might benefit from custom settings. 

Configure Custom Settings 

There are six different panels in the PDF Optimizer dialog box that you can work with to 

reduce the size of a PDF. 

Images 

The Images panel of PDF Optimizer lets you set options for colour, grayscale, and 

monochrome image compression, and image down sampling. Down sampling reduces 

file size by lowering the resolution of images, whereas image compression reduces file 

size by eliminating unnecessary pixel data. 
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In general, JPEG 2000 and JPEG give better results on photographs and ZIP is the 

better choice for illustrations with large areas of solid, flat color. 

(Flat Colour - Printing two or more colours without overlaying colour dots. This differs 

from process colour, which is a blending of four colours to produce a broad range of 

colours.) 

For monochrome images, JBIG2 compression is superior to CCITT. 

(Monochrome describes items in one colour or shades of one colour. A monochromatic 

object or image has colours in shades of limited colours or hues. Images using only 

shades of grey (with or without black and/or white) are called grayscale or black-and-

white.) 

Fonts 

In the Fonts panel you can conserve space in a PDF by un-embedding the fonts, but 

then there are no guarantees that people viewing your PDF will see it as you intended. 

A better choice is to subset all embedded fonts. That way you retain the look of your 

PDF without carrying the overhead of characters that are not being used. 
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Transparency 

If your PDF includes artwork with transparency, you can use the options in the 

Transparency panel to flatten transparency and reduce file size. 

Discard Objects / Discard User Data 

The Discard Objects panel and the Discard User Data panel let you specify objects and 

data to remove from the PDF. 

Clean Up 

Finally, the options in the Clean Up panel remove useless items from your document. 

Once you have created some custom settings, you can save them with a unique name 

so that you can come back at any point in the future and go directly to those settings. 

Final Steps… 

5. Next choose the Acrobat version compatibility that you want. 

The later the version you choose, the better the compression you will be able to 

achieve. However, you will want to select a version that you think will include the 

majority of your viewers. (Adobe Reader 7 would be the minimum) 

6. Once you have finished making all your choices in PDF Optimizer, select the OK 

button on the bottom right. 

7. Then in the Save As dialog box that comes up, give your file a new name so that 

you can always go back to the source file in case there was something you didn't 

like about what you did in your optimized PDF. 

If you want to see detailed information on every element in PDF Optimizer, go to the 

Adobe Acrobat XI Pro Help file. 

 

To watch an Adobe Video Tutorial on Optimizing your PDF File - Press CTRL + click on 

the link below: 

http://acrobatusers.com/tutorials/how-optimize-your-pdf-file 

  

http://acrobatusers.com/tutorials/how-optimize-your-pdf-file
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Microsoft Quick References 

Create Accessible Word Documents 

Microsoft Quick Reference for Creating an Accessible document 

Format your document using Styles 

Microsoft Quick Reference for Formatting your document Using Styles 

  

http://office.microsoft.com/en-us/word-help/quick-reference-card-RZ102644124.aspx?section=8&mode=print
http://office.microsoft.com/en-us/word-help/quick-reference-card-RZ001103924.aspx?section=28&mode=print
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Notes: 
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Notes: 
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